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  1.The Bullet Repository Application 
 
The application is designed to carry out the ballistic 

examination of used bullets. 
 
The window corresponding to the application can be opened in 
three ways: 
 

 Directly at the application start by selecting the menu item 
Bullet Repository in the section All Programs of Start 

Menu or by means of the shortcut  located on the 
Active Desktop; 
 
NOTE.  As the Application is started there shows the 

"Identification" form containing fields for 
entering the user identifier and password, as well 
as the buttons to confirm or cancel the user 
parameters input.  

 

 
 

Upon pressing the OK button the system checks 
for the presence of the user with the entered 
identifier in the database and the correctness of 
the password entered. The user is allowed three 
attempts to correctly enter the system. Pressing 
the Cancel button cancels the start of the 
Cartridge-case  Repository application. 

2 47 



   By pressing the corresponding Switch to button in the 
TeleMicroscope window; 

 Automatically after recording the image of a lateral bullet 
surface.   

 
2. Interface Description 

 
The main application window contains a menu, a panel bar 

with a set of control buttons, a scale-setting window and two 
windows for images output with information elements – a 
horizontal limb and a vertical scale.  

 
NOTE: If two images are loaded into the windows, one of them 

will be "active" (marked by light-gray background of the 
lighting direction indicator in the right upper or right 
lower corner). To make an image "active" move the 
cursor onto its field and press the left mouse button. 

 
The figure shows the main window of the Bullet Repository 

application, which appears as soon as the application is started. 
The main window includes two "working" windows. The 

lower window displays the specimens loaded from the database, 
while the upper window displays the specimen under examination.   

 

specimen loaded into the upper window press the Base button) 
may be shown in the root of the tree. The opening list of experts' 
names is located in the upper part of the form. To view the 
coupled objects marked by one of them flag the corresponding 
name.   

Comments to the selected couple, as well as the list of 
experts having also marked these specimens as "coupled" are 
displayed under the list of specimens.  

To load the selected couple select the specimen located in 
the tree leaf and press the Load button. If the couple has been 
marked by several experts one can select the expert's name with 
his/her comment in the field of comments to the specimen.  

 
Two loading modes are possible: of both specimens of the 

couple or only of the selected specimen. In the first case the image 
of the specimen located in the overlying tree knot will be loaded 
into the upper window, while the image of the selected specimen 
will be loaded into the lower window. The images will be 
positioned according to two coordinates in such a way that the 
marked matching area is located in the screen center. At this point 
the simultaneous viewing mode will be automatically activated. 
The marked area will be displayed as a triangle in the upper and 
lower viewing windows.  

In the second case the image of only the selected specimen 
will be loaded into the lower window. If the image of a specimen 
marked as "coupled" to the specimen being loaded is loaded into 
the upper viewing window, the images will be positioned with 
regard to the marked matching area. Otherwise, the program will 
inform that the specimens were not marked as "coupled". 

To delete the connection between two specimens select a 
couple of specimens and press the Delete button. 
The menu item Coupled specimens->Synchronize is accessible 
in the two specimens comparison mode. If the specimens are 
marked as coupled in the database, they will be positioned with 
regard to the marked matching area, and the program will activate 
the simultaneous viewing mode. The matching area marked by the 
expert will be displayed as a rectangle in the upper and lower 
viewing windows. 
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1. Main program menu. It contains commands changing the 

application’s operating mode. 
2. Tool bar. Contains control buttons duplicating program menu 

items. The main purpose of the tool bar is to facilitate the user 
access to the main program commands.  

3. Heading of the main application window. It contains the 
application name, as well as the "active" specimen identifier.  

4. Left part of the main application window state line. It displays 
overhead information. 

5. Opening list of the image scale options. In this list one can 
select the specimen image scale in the upper and lower 
window. It is set simultaneously for both specimens. 

6. Opening list of firearm system options. In this list one can 
select a firearm system for a new (recorded) object under 
examination. Specimens loaded from the database can be only 
of the same firearm system.  

7. Numbers of rifle fields. The marks on the horizontal limb show 
the points of the intersection of rifle trace border lines with the 
lower object image border.  

NOTE: Both object images marked as "coupled" should be 
preliminarily saved in the DB. 

To view the list of coupled objects (specimens) select the 
menu item Coupled specimens->Show. The Coupled Specimens 
form appears on the screen.  

 

 
 
The window shows a list of coupled specimens in the form 

of a "tree". Either several specimens (to display all the coupled 
specimens press the Show All button) or one specimen currently 
loaded into the upper viewing window (to display only the 
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  8. Lighting direction indicator (from the left or right) by recording 
an object surface image. It also shows the "active" (light-gray 
background) or "passive" (dark-gray background) image 
window. This is a "passive" specimen.  

9. Lighting direction indicator (from the left or right) by recording 
an object surface image. It also shows the "active" (light-gray 
background) or "passive" (dark-gray background) image 
window. This is an "active" specimen. 

10. The right part of the main window application state line. It 
shows the coordinates of the cursor position inside the "active" 
window (in pixels) or the phrase "Outsides the area", if the 
cursor is outsides the window. 

11. The field of the selected command execution indicator. While 
long operations are being carried out it displays the current 
percentage of the selected command execution. The indicator 
disappears from the screen after the task has been fulfilled. 

12. Horizontal limb. It shows the angular distance (in degrees) 
from the beginning of the object surface image record. 

13. Vertical bar. It shows (in mm) the distance from the lower 
border of the object surface image record. 

14. Image window in tracing mode. It displays the image obtained 
by superposing the image of the object loaded into the upper 
window, with a transparency factor (a) and the image loaded 
into the lower window, with a transparency factor (1-a). 

15. Tracing mode control panel. 
 

 

Button for switching over to the 
TeleMicroscope window  
Opens the TeleMicroscope application 
window. 
It is accessible only for the data acquisition 
workstation (DAS) operator. 
 

 

Specimen Import button    
Opens the Specimen import form ("Open").  
The form description is given below. 
 
 

20. Work with Coupled Objects 
 

The mode allows to mark objects as "coupled" by marking 
out and saving in the DB the most coinciding parts of the images, 
upon which they are automatically positioned. This mode is 
convenient for detecting the interconnection of objects related to 
different criminal cases. For example, if an expert working on one 
criminal case has established that object A belongs to the same 
barrel as object B, while an expert working on another criminal 
case has established that object B belongs to the same barrel as 
object C, then the given mode can help establish a connection 
between these criminal cases.  

 
To mark objects as "coupled": 
 
1. Align the images of object marks in the upper and 

lower window in the optimal way.  
2. Select the menu item Coupled specimens->Mark. 
3. Then mark by a rectangle the matching areas on both 

specimens by pressing the right mouse button. 
4. Release the right button. At this, the Comments to 

Coupled Specimens form will appear on the screen. 
 

 
 

5. Having entered the comment save the information in 
the DB by pressing the Save button.  

6. Upon pressing the Cancel button the information 
about the coupled objects will not be saved in the 
DB.  
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Bullet Repository Browser button 
Opens the Bullet Repository browser form.  
The form description is given below. 
 

 

Add Specimen to the Database button  
Opens the Add Specimen to the Database 
form. 
The form description is given below. 
 

 

 

Autoidentification button 
Activates the Autoidentification mode. 
The description is given below. 

 

Copy button  
Enables one to copy an image visible on the 
screen into the clipboard to be entered into 
the expert's file document. 

 

Print button  
Calls the window of the image preparation for 
print. Depending on the type of the printer 
being used select the corresponding printing 
settings. Only the parts of images and 
specimen information forms visible in the 
windows are output for printing. If specimens 
are loaded into both viewing windows, a 
dividing white strip will be drawn between 
them by printing.  

 

 

List of Loaded Specimens button  
Opens the List of Loaded Specimens form. 
The form description is given below. 
 

 

Assign Examined Status to the Specimen 
button 
On pressing the button the image, which is 
located in the lower window and is "active", 
is assigned the status of the image under 
examination. In this case the object image 
moves from the lower window to the upper 
one. 

2. To view the results of the previously made 
autoidentifications related to all specimens select the menu item 
File->Load autoidentification results. At this, the form will 
appear on the screen: 

 

 
 
 
The list of autoidentifications whose results have been saved 

in the DB, indicating the identifier of the specimen with which the 
autoidentification was carried out, trace type, firearm system, 
operator and the date of carrying out the autoidentification is in 
the upper part of the form. 

In the upper part of the form there are the lists of criteria to 
be used to curtail the list of autoidentifications (by flagging them). 
In case any selection criteria are changed the list will be 
automatically re-formed. To view the autoidentification results 
select the corresponding line in the list and press the Load button. 
The results of the selected autoidentification will be loaded into 
the Autoidentification Results form. Besides, the corresponding 
specimen will be loaded into the upper window of the Bullet 
Repository application. 
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Switch to the Next Loaded Specimen button 
On pressing the button the "active" object in 
the lower window is replaced by the next one 
out of the list of objects loaded into the 
memory. If only one object is loaded into the 
memory from the DB, the button is "passive". 
 

 

Unload Specimen button 
On pressing the button the "active" object 
displayed in the lower window is removed 
from the list of loaded objects and from the 
memory. Further access to this object is 
possible after its reloading from the DB. 
 

 

Synchronize View button 
On pressing the button the object images 
displayed in the upper and lower windows 
will shift synchronously. 
 

 

Full Screen button   
On pressing the button the "active" image 
expands over the entire screen, on repeated 
press it "contracts" to its original size. 
 

 

Shift to Image Edges buttons 
On pressing the buttons the "active" image 
shifts on the screen to the corresponding 
image border (upper or lower). 
 

 

Next Rifle Trace buttons 
On pressing the buttons the "active" image 
shifts on the screen to the left and to the right 
over a distance equal to that between two 
neighboring rifles. 

 

 

Marking of Rifling Traces button 
Opens the Marking of Rifling Traces form 
The form description is given below. 
 

Viewing of previously saved autoidentification results 
 

The program provides for two ways of viewing the 
previously saved autoidentification results.  

1. In the autoidentification mode press the Load Results 
button in the Autoidentification Results form. The Saved 
Autoidentification Results form appears on the screen. 

 

 
 
In the window contains a list of the previously made 

autoidentifications related to the specimen under examination, 
indicating the expert who has carried out the autoidentification, 
the date of the autoidentification and the type of traces it was 
based upon. To view the previously made autoidentifications 
results select the corresponding line in the list and press the Load 
button. 
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Show marked traces borders button 
On pressing this button trace borders appear 
or disappear on the "active" image. At the 
same time the rifle number markers on the 
horizontal bar remain highlighted. 

 

 

Marking of Additional Traces button  
Opens the Marking of Additional Traces 
form. The form description is given below. 

 

 

Display Mode button 
Opens the Display Mode form. 
The form description is given below. 

 
 
 
 
 
 
 

 

Image Rotation button 
Switches on the rotation mode in the "active" 
viewing window. To rotate the image move 
the cursor to the blue line, which appears on 
the screen, press the left mouse button and 
move the line until the required angle is 
obtained (the current angle value is shown in 
the right lower corner of the viewing 
window). On releasing the key there appears 
on the screen a form in which to confirm the 
rotation over the selected angle. The rotation 
angle value can be edited in the form window. 
The software provides for a limitation of the 
image rotation angle - + 15 degrees. After the 
image rotation has been carried out the 
program automatically switches off the 
rotation mode.  
 

 

Magnification of Images button  
The description of the action is given below. 

 

Tracing Mode (Superposition of Image) 
button 
Switches on the mode of the semitransparent 
superposition of object images loaded into the 
upper viewing window and lower one.  
The description is given below. 

When ranking specimens by secondary traces one can view 
the images of the selected areas coinciding in the optimal way 
with the traces on the specimen under examination. For this press 
the Show traces button. The Viewing of Traces form appears. 

 

 
 
The image of the trace area of the specimen under 

examination, which coincides in the optimal way with the 
specimen trace from the list located above it, is located in the 
upper part of the form over the red line. The information form of 
the corresponding specimen is located to the left of the trace 
image. One can scroll the list of images up and down using the 
corresponding buttons located in the lower part of the window. To 
load a specimen from the list select it with the mouse and press the 
Load button. Upon loading the image under examination and the 
image to be checked will be superposed according to two 
coordinates in such a way as to allow the operator to view the 
parts of rifle traces with the highest similarity degree in the screen 
center. 
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Measure Lengths and Angles button 
Switches on the mode of measuring the 
distance between two points and an angle 
relative to the vertical. First mark the base 
point relative to which measurements will be 
made. For this bring the cursor to the point of 
interest and press the left mouse button. Then, 
holding the button down, bring the cursor to 
the second point of interest. The angle and 
distance values between the base point and 
the cursor are displayed in the Measurement 
form. The form description is given below. 
 

 

Brightness and Contrast button 
Opens the image brightness and contrast 
adjustment form. The form description is 
given below. 
 

 

Information about Traces button 
Opens the Information about Traces form. 
The form description is given below. 
 

 

Show Bullet Cross-Section button  
Opens the horizontal bullet section display 
window. The description is given below. 
 

 

About Program button 
Opens the window showing information 
about the program. Note. Help is called by 
pressing the F1 key. 
  

 
 
 
 
 
 
 

 
Specimens in the list are arranged in the descending order of 

the degree of similarity to the object under examination in the 
corresponding trace. Furthermore, to the left of the specimen name 
is a pictogram of green, yellow or red color containing additional 
information for the user as to the actual extent of similarity of the 
given object’s trace border coordinates with those of the object 
under examination:  

- Green – great extent, 
- Yellow – medium extent, 
- Red – lesser extent. 

To view information about a specimen, click the left mouse 
button on the specimen identifier in the list.  

To view the image of the bullet selected in the list, press the 
Load button.  

 
NOTE:  The image from the database and the image under 

examination will be positioned according to two 
coordinates in such a way as to allow the operator to 
view the parts of rifle traces with the highest similarity 
degree in the screen center. 

9 40 



  3. Specimen Import 
 

This mode is designed to provide for the opportunity to enter 
into the DB specimens recorded by other Condor systems.  

To initiate the procedure of importing the file containing 
information about the specimen select File-> Specimen Import in 
the main application menu or press the Specimen Import button 
on the main application window tool bar. This will result in the 
appearing of the Open form.  

 

 
 
In this form select the file to be imported and press the 

Open button.  
 
The user is offered to select the firearm system and the 

object material from those registered in the database. For this 
purpose there appears on the screen the Choice of Firearm 
System and Material form. 

 

 Depending on the selected traces the autoidentification will 
result in forming corresponding lists.  

The Firearm System field, in addition to the firearm system 
name of the object under examination, also contains the firearm 
system names from the DB having similar parameters: caliber, 
number of rifles and direction of rifle traces. The user can add the 
objects of these firearm system names (by flagging them) to the 
autoidentification. 

The operator can curtail the list of objects for 
autoidentification. For this select a criterion (by flagging it) and a 
line in the opening lists of the group of control elements 
"Selecting criteria". The selection is carried out according to the 
following criteria:  

• Name of the operator who has entered the 
information into the DB; 

• Object jacket material; 
• Object type – test fire or criminal; 
• Temporary specimen record range in the DB. 

NOTE:  Using the Expanded Search option may improve 
the autoidentification results on secondary traces 
and rifle bottom traces through the use of additional 
information.   

Press the Search button to start the autoidentification 
procedure. The message "Sorting of the list completed!" shows 
as the procedure is over. 

 
 

Viewing the autoidentification results 
 
Appearance of the Autoidentification Results form upon 

completing the ranking procedure: 
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Firearm system properties (name, caliber, number and 
direction of rifles) are read out from the imported file and 
displayed in the information fields. The names of all the firearm 
system registered in the DB are in the list of firearm system 
selection box. The user can select a firearm system similar in 
characteristics to the one from the file or ask the Administrator to 
register a new firearm system in the DB.    

Following the successful file import the image will be 
displayed in the upper viewing window (the specimen will be 
assigned the "under examination" status). To save the specimen in 
the database press the Add Specimen to the Database button on 
the main application window tool bar. 

 
 
 
 
 
 

 
 
Control buttons: 
 
Search…  starts the automatic search procedure; 
Show traces   opens the Viewing of Traces form. The form 

description is given below;                             
Load Results  loads from the DB the results of the 

autoidentifications on the specimen under 
examination made earlier; 

To MS Excel  displays the autoidentification results in the MS 
Excel format (version 7.0 and higher); 

Load  loads the selected specimen into the lower viewing 
window; 
Save Results  saves in DB the result of the carried out 
autoidentification; 
Hide   hides the form; 
 
NOTE: In this mode a number of buttons of the main application 

window become inaccessible.    
 
Close  closes the form; 
Help  provides necessary information on the given form. 
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  4. “Bullet Repository Browser” form 
 

It opens on pressing the Bullet Repository Browser button or 
on selecting the corresponding menu item File->Bullet Repository 
Browser.  

It allows to view the contents of the bullet repository (DB) 
storing the images of the objects grouped by firearm system, as 
well as information cards accompanying them. Viewing the 
contents is carried out by browsing through individual object 
image codes (identifiers) of specimens with information cards 
about them. 

 

 
 
Control buttons: 
 
Export  enables the highlighted specimen to be recorded as a file 

to be transferred (exported) to another Condor 
system; 

NOTE:  By selecting the specimen identifier out of the list and by 
pressing the Export button the user will be offered to 

19. Autoidentification Mode 
 

The mode is designed to carry out an automatic ballistic 
examination. It allows to form for the bullet under examination a 
list of bullet specimens from the DB having similar parameters 
(caliber, number and direction of rifle traces) and arrange this list 
in the descending order of the degree of matching with the bullet 
under examination. 

 
Autoidentification start 

The mode is activated by means of the Autoidentification 

button or by selecting the menu item Viewing-
>Autoidentification, upon which there appears the 
Autoidentification form.  

 
NOTE:  The button and the menu item are accessible only in 

the case the image of the object under examination 
with marked traces is loaded into the upper window of 
the Bullet Repository application.  

 

 
 
In the form mark the traces to be the base for the 

autoidentification and press the Start button. The 
Autoidentification Results form appears.  
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  18. Specimen Selection according to Preset Criterion preset the name of the file under which the specimen will 
be recorded. Information on recording process is 
displayed in the Status of Specimen Loading form. The 
following information will be saved in the file: 

 

 
The mode is designed to form a list of objects from the DB 

corresponding to the preset criteria. 
Upon selecting the menu item View->Specimen selection 

according to preset criterion there opens the Specimen 
Selection according to Criteria form. 

 

• Specimen identifier, 
•  Bullet surface image, 
•  Firearm system name, as well as additional 

information including the caliber, number and 
direction of rifles, 

• Lighting direction by recording the object image, 
• Initial object scanning position, 
•  Name of the bullet material, 
•  Brightness and contrast values set by the operator 

who carried out the bullet scanning. 
 

The file formed in this way can be recorded onto a portable 
information carrier and imported to another CONDOR system. 
 
Delete   marks specimen as “to be deleted” in the DB. The 

physical removing of the record from the database and 
of the corresponding image file is performed from the 
Administrator software; 

Edit   opens the text fields of the object information card for 
editing; 

Load   loads the selected object into the lower window of the 
Bullet repository application; 

Close   closes the Bullet Repository Browser form; 
 Help   provides the necessary information about the form. 
 
List formation by criteria 
 

 
It contains the main specimen classification properties by 

which they are stored in the DB. To include a parameter in the 
search criterion check the field (by flagging it) and select a line 
out of the opening list or input search information and then press 
the Select  button. 

 The left window will display identifiers of all the specimens 
satisfying the preset criteria.  

The list of specimens in the left viewing window can be reduced 
by presetting selection criteria. The selection can be carried out 
according to one or several of the criteria listed below: Pressing the Load button allows to load a specimen for 

viewing selected from the list into the lower window of the Bullet 
Repository application. 

• Operator having recorded the specimen in the DB. 
• Object material. 
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  • Object type (object from the crime scene or test-fired 
in the laboratory). 

• Date of entering the specimen in the DB (by setting 
time interval). 

To set the selection criteria select the mark (by turning on the flag) 
and the line in the opened lists of the control elements group 
"Selecting criteria". In this case the list of the specimens to be 
displayed will be automatically re-formed.  
 
Loading Specimens from the DB 
 

To load the selected specimen into the viewing window, 
press the Load button. Depending on the type of connection to the 
storage server the process of image loading may take from several 
seconds (in case of broad band connection) to several minutes (in 
case of narrow band, modem connection). The image loading 
process is displayed in the Status of Specimen Loading form.  

 

 
 
Located in the upper window part are the information fields 

showing the number of the files waiting for their turn to be loaded 
from the server, as well as the maximum priority of the loading 
assignment. In the lower part there are the display windows for the 
specimen identifiers whose files are loaded from the server or 
recorded onto the server. The window shows the specimen 
identifier and the percentage of the loaded information volume. If 
the user has changed his mind about loading the specimen from 
the server, he can select the specimen name in the viewing 

17. Viewing of the Form of the Horizontal Section of 
the Scanned Object 

  
 
This mode is designed to display the horizontal bullet 

section corresponding to the first band level of the recorded 

image. It is called by the  button or by selecting the 
corresponding menu item Modes->Bullet cross-section. It 
displays the horizontal bullet section of the "active" object image. 

 

        
 
 
The real bullet cross-section is shown in green, while the 

circumference drawn with a radius corresponding to the firearm 
system caliber is red. The circumference radii indicate the borders 
of the visible image zone in the viewing window.  
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  window and press the Delete button.  
If the user wishes to load a specimen in the first place 

without canceling current specimen loadings, he/she can raise the 
priority of the specimen to be loaded by means of the loading 

priority slider  located in the lower part of the 
form "Bullet Repository Browser" under the list of specimen 
names.   

 
Restoration of deleted specimens 
 
The list of the specimens marked for deletion but not yet 

physically deleted from storage servers can be displayed by 
marking the Restoring mode field. In this case the user can 
restore an accidentally removed specimen by selecting it in the list 
and pressing the Restore button. At this point the form will be 
transferred into the specimen information card editing mode. 

 

 
 

• Number of actually marked traces. 
Information about the characteristics of the first rifle trace 

visible on the screen is displayed in the upper part of the form. 
With the aid of the upper tabs one can select the type of the trace 
the information on which is to be displayed – primary or 
secondary. The insert fields display: 

• Trace number; 
• Inclination angle of the left trace border in degrees; 
• Inclination angle of the right trace border in degrees; 
• Trace width of the lower image part; 
• Trace width of the middle image part; 
• Trace width of the upper image part. 
 
With the aid of the control buttons located in the lower part 

of the window one can move the image to the next or preceding 
traces. 
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  The user can select specimen to be restored and, by pressing 
the Restore button, change the information about it, then save this 
information in the DB (by pressing the Update button, which 
substitutes the Restore button). After the specimen restoration the 
form will switch to the mode of viewing the bullet repository 
contents, from which the user can load the restored specimen. 

 
5.“Add Specimen to the Database” form 

 
It opens on pressing the Add Specimen to the Database button 

or by selecting the corresponding menu item File-> Add 
specimen to the database. 

It allows to enter a new image into the bullet repository and 
fill out an information card about it or to change the information 
about the specimen already existing in the DB. 

 

 

16. Viewing of Object Characteristics  
 

The mode is designed to present metric information about 
the traces of the object stored in the DB. It is activated by means 

of the  button or by selecting the menu item Modes-
>Information about the rifling traces. This calls the 
Information about traces form.  

 

 
 
The lower part of the form displays the following 

information about the "active" specimen: 
• Specimen identifier; 
• Firearm system; 
• Object diameter and image record height in millimeters.  
NOTE:  The diameter and height are calculated on the basis 

of the real image size. Therefore, if the image is 
highly deformed, the object diameter may differ 
from the caliber for the given firearm system. 

• Number of rifles for the given firearm system. 
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  Control buttons: 

 Add  allows to enter an object image with a filled out information 
card in the bullet repository;  

            NOTE:  If a specimen is called from the DB for 
introducing changes, the Update button is 
substituted for the Add button. 

Cancel  closes the Add Specimen to the Database form without 
saving information in the DB; 

Browse…:   opens the Criminal Case form. The form description 
is given below; 

Help   provides necessary information on a given form. 

6. “Criminal Case” form 
 

It allows to view the criminal cases registered in the bullet 
repository, edit them or add new ones.   

 

 

The clearance of image fragments is carried out in the 
following sequence:  
1. Select the fragment. For this mark the left and right vertical 

fragment borders by double-clicking the left mouse button, 
when the cursor is on the graduated limb. At this point on the 
image there will appear dark-yellow vertical lines signifying 
the borders of the fragment to be deleted.  

     With the aid of the Delete button one can cancel the selection 
of the "current" fragment borders. 

2. Mark the remaining fragments to be removed. The fragment 
numbers are displayed in the information window of the form. 

      
NOTE:   To  switch  to  fragments   select   their  number  in  the  
information  window of the  
                     form.  
3. Delete the marked fragments by pressing the Clear button.  

NOTE:    Once saved in the database, the deleted fragments 
cannot be restored. 
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  Control buttons: 

Add   allows a new criminal case to be registered in the bullet 
repository; 

Edit  allows to edit data on a criminal case, which is already in the 
database; 

 Delete  deletes information about a criminal case from the 
database; 

ATTENTION! If there are specimens concerning to this criminal 
case, the button is disable.  

Select  transfers the selected criminal case into the Add Specimen 
to the Database form; 

Close  closes the Criminal Case form; 

 Help  provides necessary information on a given form. 

 

 

 

 

 

 

 

 

 

 • Buttons with arrows in the lower and upper slider part – 
serve to move the image in the corresponding window. 
When the mode of synchronized object image movement is 
activated, irrespective of which button is pressed, both 
images move simultaneously.  

• The Alternately button – activates the cyclic switching 
mode of images loaded into the upper and lower viewing 
windows in the tracing region. The images are switched at 
a frequency of 2 Hz.  

• The Close button – closes the tracing mode. 

 

15. Clearance of Image Fragments 
 

This mode is designed to edit object images – delete the 
fragments of object images that do not contain useful information 
(for example, highly defocused areas).  

NOTE: Only newly scanned images, which are not yet 
entered in the system's database, can be edited.  

It is activated by selecting the menu item Modes-
>Clearance of image fragments. There appears on the screen the 
Clearance of Image Fragments form. 

 

 

18 31 



  7. “List of Loaded Specimens” form  
 

It opens on pressing the List of Loaded Specimens button 
or by selecting the corresponding menu item View-> List of 
loaded specimens.  

The form window displays the identifiers of the specimens 
loaded into the Application from the database. 

 

 
 
To switch over to the required specimen select it out of the 

list and press the Switch to button.  
To remove a specimen from the Application select it out of 

the list and press the Unload button. 

 

 
 
 

14. Image Superposition Mode – Tracing Mode 
 

Is designed to increase the efficiency of comparing the two 
objects’ traces. 
It is switched on by means of the Tracing Mode button or by 
selecting the menu item Modes->Superposition of Images. At 
this in the screen center there appears a rectangular area with an 
image obtained by mutual superposition of objects loaded into the 
upper and lower windows, with different transparency factors. The 
tracing mode control panel will appear in the right part of the 
tracing window. 
 

 
Control elements on the panel: 

• Slider – adjusts the image transparency factor. The upward 
slider movement decreases the transparency factor of the 
image loaded into the upper window and increases pro rata 
the transparency factor of the image loaded into the lower 
window, and vice versa. 
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  8. “Display Mode” Form 
 

It opens on pressing the button or by selecting the 
corresponding menu item View ->Display mode.   

 

 
 

The program provides for four object image display modes: 
 
• Full object image, 

• Only primary traces, 

• Only secondary traces, 

• Primary and secondary traces. 

To switch over to the required mode select it in the menu 
and press the Display now button. At this the program will switch 
to the selected display mode in both viewing windows. 

NOTE:  If in one of the windows no trace is marked on the 
object image display mode will not change.  

On the second press of the Display now button the form will 
be closed, with the program remaining in the selected display 
mode.  

 
 
 
 

13. Magnification of Images Mode  
 

Is designed to carry out a more exact alignment of images in 
the upper and lower viewing windows at the established scaling 
factor of less than 1.  

On pressing the  button on the tool bar or selecting the 
menu item Modes->Magnification of images there appears in the 
screen center a rectangular area in which magnified image 
fragments located in the upper and lower viewing windows at their 
common border are displayed. The form for setting the factor of 
magnification appears in the left part of the screen.  

In the form one can select the factor of fragment 
magnification within the range from the current scaling factor to 1.  

 

 
 

One can exit the mode by pressing the   button on the 
tool bar or by unflagging the corresponding menu item. 

20 29 



  9. Work in the Bullet Repository Application 
 

Recording an object images into the Bullet repository 

NOTE:  Only the object image from the upper viewing 
window can be recorded into the bullet repository. 
This image can be either transferred from the 
TeleMicroscope application or imported from a 
file. 

1. Press the Add Specimen to the Database    button.  

2. Fill out the fields being edited in the Add Specimen to the 
database form. 

3. Select the criminal case name from the list, in case it has been 
registered earlier. 

4. Select the Browse… button for editing or entering information 
about the new criminal case. 

5. In the Criminal Case form: 

а) Press the Edit button and introduce changes in the 
information about the already registered criminal case and 
then press the Save button, 

b) Press the Add button and fill out the information fields 
about the new criminal case, then press the Save button. 

6. Select object type:  Criminal is an object from the crime scene; 

                                    Test fire is an object of the firearm gun 
being tested. 

sheet size will be output for printing (the factor of image 
magnification may change from 1 to 4). Otherwise, the image is 
output for printing on the initial scale. 

3. To carry out the marking bring the cursor to the upper left or 
lower right corner of the area being marked, press the right 
mouse button and, while holding down the button, draw out the 
emerged outline.  

4. Input the comment for the marked area into the comment field.  
NOTE:  The outline of the "currently selected" marked area 

is red. All the other areas are highlighted in green 
outline. The ordinal number is output in the upper 
left corner of the outline.  
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  7. Press the Add button in the Add Specimen to the database 
form. 

 

Loading of object images from the Bullet repository 

1. Press the Bullet Repository Browser    button.  

2. In the Bullet Repository Browser form: 

а) Select the firearm system, 

b) Select the specimen identifier. 

3. Press the Load button. 

NOTE:  The image is loaded into the lower viewing 
window of the Bullet Repository application.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

12. Mode of Marking Additional Traces 
   

Is designed to highlight on an image or a DB record 
rectangular areas containing additional information necessary for 
the expert's work. 

 
NOTE: Additional traces are not used for the automatic 

search. 
 
1. Make the image "active". 

2. Press the  button or select the menu item Modes-
>Marking of additional traces. At this there will show the 
Additional Traces form.  
Control buttons used to save, delete the marked area, switch to 
the next or preceding marked area, print out or call contextual 
information are located in the upper window part. The field for 
inputting the comment to the current highlighted area is located 
under the buttons.  
The field for selecting the "Scaling" print mode is located 
below. By checking this field an image fragment scaled to the 
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  10. Object Image Comparison Mode   
 

Is designed to carry out ballistic examination by comparing 
the images of characteristic object traces on the monitor screen.  

The image of the object under examination is always loaded 
into the upper viewing window (by transferring from the scanner 
or by importing the specimen from the file).  

The image being loaded from the bullet repository may be 
made the one under examination. In this case the image is 

assigned the examined status by pressing the  button or by 
selecting the menu item Comparison mode->Assign examined 
status to the specimen after it has been loaded from the database 
into the lower window of the Bullet Repository application.  

The images of the objects with which the object under 
examination is being compared are loaded from the bullet 
repository into the lower viewing window. 

Use mouse to move the images in the viewing windows. The 
image in the window will shift together with the cursor, with the 
left mouse button being held down. 

The button provides for the  simultaneous viewing of 
two images. It means that the images will move synchronously 
within the limits of their display windows.  

The functions of the other buttons providing for the work 
with images is explained in the description of the Bullet 
Repository application. 

 
 
 
 
 
 
 
 
 
 

bring the cursor to the upper region boundary and 
click the right button. On the image there will appear a 
horizontal line signifying the upper boundary of the 
secondary trace region. Then mark the lower boundary 
in a similar manner. 

• Mark the remaining traces in a similar way. 
 

NOTE:  The marked borders have the following color: red – 
own border of the primary trace, green – common 
border of the primary and secondary traces and 
blue – own border of the secondary trace.  

NOTE:  To delete the last marked border press the Delete 
Border button, and to delete the whole marked 
trace - the Delete Trace button.  

 
5. Mark the rifle bottom trace borders in the following way: 

• Bring the cursor to the upper point of the left rifle 
bottom trace border. 

• Press the right mouse button and, while holding it down,  
move the cursor parallel to the strokes toward the lower 
point of the left trace border and then release the button. 

• Mark the right trace border in the same way. 
• Draw a horizontal line between the borders, which 

crosses the most characteristic strokes – bring the cursor 
to the assumed line and click the right mouse button.  

 
NOTE: The marked borders are pale blue. The horizontal 

line is dotted. 
 
6. Save the trace border coordinates in the DB by pressing the 
Save button.  

 
NOTE: If the user forgets to save the marked traces in the 

DB, the program will offer to do this on 
exiting from the trace-marking mode. If 
the user refuses to save them, the newly 
marked traces will not be displayed in the 
viewing window.  

23 26 



 11. Marking of Rifling Traces Mode 
 

Is designed to leave mark traces on an image and save the 
coordinates of rifle trace borders and rifle bottoms in the DB. The 
border coordinates are used for the automatic search in the DB for 
objects "similar" to the one under examination. 
 
Work procedure: 
1. Load the image from DB or obtain it from the TeleMicroscope 

application. 
2. Move the image in such a way as to make the whole rifle trace 

or its left part visible. 

3.Press the  button or select the menu item Modes-> 
Marking of Rifling Traces. At this, the Rifling Traces form 
will appear.  

       Its upper part displays the buttons by means of which the 
marked trace borders can be saved in DB and the last marked trace 
border or the whole marked trace can be deleted.  

Under the buttons there are located the tabs with the aid of 
which the marked traces selection can be made: 

• Marking the borders of primary and secondary traces, 
• Marking the borders of rifle bottom traces. 

The information fields contain information about the number of 
traces, the number of traces to be marked, the type of the border to 
be marked and the inclination angles of trace borders. 

The group field in which the types of the traces to be marked 
on the given specimen image are selected is located in the lower 
form part.  
4.  Mark trace borders in the following way: 
NOTE:  Border marking sequence: "from left to right" for the 

rifles’ right inclination angle and "from right to left" 
for the left one. 

• Bring the cursor to the upper point of the border of the 
trace to be marked. 
• Press the right mouse button and, while holding it 

down,  move the cursor parallel to the strokes toward 

the lower point of the trace border and then release the 
button. 

  
 

• Mark the next border of the trace to be marked in the 
same way. 

• For secondary traces mark the upper and lower 
boundaries of the most informative regions (the lower 
part of the trace image with strokes parallel to the 
borderlines, see fig.).    

 

 
 
After marking the right border of the secondary trace 
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